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			Sobre os autores

			Ricardo Minoru Horie 

			Atua há mais de 20 anos na indústria gráfica no segmento de pré-impressão com treinamentos e consultorias técnicas para empresas, além de ministrar regularmente seminários, palestras, oficinas e cursos pelo País.

			Autor de mais de 40 livros técnicos na área de editoração eletrônica, dentre eles: “Coleção InDesign“ “Acrobat Pro e Pro Extended para uso gráfico”, “Acrobat 7 Professional para uso gráfico”, “PitStop Pro – Análise e edição avançada de PDFs”, “Dicas, Truques & Macetes – Adobe InDesign”, “Arte-finalização de Arquivos para Artes Gráficas”, “Catálogo de Fontes do Font Folio 9“, “Utilizando o Photoshop” e “Utilizando o InDesign”.

			Foi pioneiro como autor de livros eletrônicos para o segmento gráfico no Brasil. É beta tester de vários produtos tais como InDesign, Acrobat e PitStop.

			Por mais de uma década colaborou com a edição brasileira da revista Publish, tendo atuado como colunista e editor executivo. Desde 2007 passou a compor a equipe de colunistas, palestrantes e consultores da revista Desktop. Também é membro das comissões de estudos de Pré-Impressão Eletrônica e Impressão Digital da ONS 27/ABTG.

			Foi colunista do jornal “O Estado de São Paulo” e docente do curso superior de tecnologia gráfica do Senai “Theobaldo De Nigris”, considerado e reconhecido internacionalmente como o mais importante centro de aprendizado gráfico na América Latina.

			É sócio/diretor junto com André Borges Lopes na Bytes & Types (www.bytestypes.com.br), empresa especializada em consultorias técnicas e treinamentos na área gráfica.

			Ana Cristina Pedrozo de Oliveira 

			Designer e técnica em produção visual gráfica pelo Senai “Theobaldo De Nigris”. Atua desde 1989 em agências, birôs de pré-impressão e gráficas desenvolvendo projetos gráficos da criação até o acabamento e acompanhando todas as fases de produção. 

			Atualmente é produtora gráfica da Fábrica de Ideias Comunicações. Especialista em Produção Gráfica e aplicativos como InDesign, Illustrator, CorelDRAW e Photoshop, ministra treinamentos em instituições como GraphWork, Senac, Senai e ABTG, além de prestar consultoria em empresas da área gráfica em São Paulo e em outros estados do Brasil.
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			Prefácio

			Diagramar é distribuir textos e imagens em uma página de forma equilibrada, respeitando os anseios do leitor e tornando sua leitura agradável e interessante.

			Os aplicativos de layout de página estão cada vez mais sofisticados quanto à disponibilidade de recursos destinados para esse fim. 

			O InDesign na versão CS5, trouxe muitas novidades na parte referente ao layout, tornando a interação com o usuário no momento da manipulação das ferramentas e dos comandos, muito mais simples e intuitiva. 

			Ele permite que os esforços estejam concentrados na montagem das páginas, seus conteúdos e na importância de cada elemento. 

			Desta forma, a criatividade não será limitada pelos recursos ou pela falta de interação do usuário com o programa.

			Convidamos você a conhecer mais sobre o InDesign CS5, utilizar seus recursos disponíveis e tornar seus projetos cada vez mais sofisticados, diferenciando-o dos demais.

			Os autores

		

		
		

		
			Sobre este livro

			Este livro tem como objetivo explicar os recursos do Adobe InDesign e como ele pode ajudar especificamente os profissionais da indústria gráfica – designers e funcionários de birôs, gráficas e editoras – de maneira geral a produzir, diagramar, editar, arte-finalizar e gerar arquivos PDF, com mais eficiência, para a produção de impressos comerciais, promocionais, editoriais etc.

			Ele foi estruturado de forma pedagógica e didática, para que o leitor, independente do seu nível de informação nos processos e aplicativos de editoração eletrônica, possa aprender ou atualizar seus conhecimentos. 

			Os recursos e comandos foram agrupados em capítulos que acompanham o processo de diagramação, arte-finalização e geração de PDFs. 

			O conteúdo do livro foi dividido em vários volumes sendo que o primeiro trata dos recursos de layout e diagramação; o segundo dos recursos de edição e formatação de textos; o terceiro dos recursos de automação e produtividade; e o quarto dos cuidados com a arte-finalização, preflight e geração dos arquivos PDF.

			Para facilitar o aprendizado, existem vários exemplos práticos passo-a-passo e os procedimentos são extensivamente ilustrados.

			Além disso, existem dezenas de valiosas dicas, truques, e principalmente avisos, recomendações espalhadas pelos capítulos e volumes. 

			Os autores procuraram inserir neste material boa parte da sua experiência na construção de arquivos para DTP, de maneira a minimizar e até eliminar os problemas na fase de pré-impressão, impressão convencional ou digital, assim como todas as formas para evitar e resolver os “pepinos e abacaxis” que porventura possam aparecer. 

			As sugestões e recomendações de configurações e ajustes nas opções, comandos e recursos foram meticulosamente estudadas para a realidade de quem precisa obter fotolitos ou chapas de impressão offset, ou mesmo impressos a partir das modernas e tão exigentes quanto, impressoras digitais comerciais.

		

		
		

		
		

		
			Como utilizar este livro

			Para melhor compreensão do modus operandi do Adobe InDesign e seus recursos, o conteúdo desye livro foi dividido em partes e capítulos cujos nomes definem de forma clara os assuntos tratados.

			Isso permite ao leitor que quer aprender ou está enfrentando algum problema específico, ou mesmo possui alguma dúvida, ir diretamente para a parte e o capítulo que trata do assunto.

			Este livro foi projetado para que os capítulos sejam completos e independentes, mas, ao mesmo tempo, que a obra possa ser lida sequencialmente, o que é recomendável, sobretudo em relação às primeiras partes e capítulos. 

			Parte I - InDesign CS5 - Layout & Diagramação

			Esta parte trata dos recursos básicos de operação do InDesign tais como ferramentas, frames, edição de elementos de página, trabalho com paths, importação de elementos externos, gerenciamento de vínculos e paginação.

			Parte II - InDesign CS5 - Textos

			A segunda parte deste livro trata dos recursos de edição e formatação de textos tais como importação, seleção, atributos de caracter, de parágrafo, correção ortográfica, além de explicar o processo de confecção e importação de tabelas.

			Parte III - InDesign CS5 - Automação de Tarefas & Produtividade

			A terceira parte deste livro trata dos recursos de automação de tarefas e de produtividade do InDesign tais como estilos de parágrafo, caracter, objetos e tabelas, Book, confecção de sumários, índices remissivos, textos variáveis e condicionais, referências cruzadas, notas de rodapé etc. O destaque são os novos recursos de revisão baseados no Acrobat.com.

			Parte IV - InDesign CS5 - Arte-Final, Preflight e Geração de PDFs

			A quarta parte deste livro trata dos cuidados com a arte-finalização de projetos gráficos, com as fontes tipográficas, cores e preenchimentos, além de explicar os recursos de preflight visual e eletrônico. O destaque desta parte é o capítulo que mostra passo-a-passo os processos mais confiáveis para geração de arquivos PDF para envio para empresas gráficas.
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			PARTE I

		

	


	
		
			CAPÍTULO 01 | OPERAÇÕES BÁSICAS

			01.1 | Criação e manipulação de páginas

			A página é a base de qualquer projeto gráfico impresso e a determinação das características desse item está relacionada com vários aspectos do projeto como formato, número de colunas, área de impressão (mancha), entre outros.

			Manipulação de páginas - procedimentos básicos

			A primeira ação para se iniciar o processo de diagramação é a configuração da estrutura das páginas. À medida que a publicação for sendo desenvolvida, ela será acompanhada por uma paleta de gerenciamento que permite inserir, apagar e modificar o ordenamento entre elas.

			Manipulação de páginas - procedimentos passo-a-passo

			1. Crie uma ou mais páginas de um documento novo por meio do comando Document no menu File > New.

			[image: New 01.jpg]

			2. Defina as configurações relacionadas com o seu projeto gráfico seguindo as descrições do quadro de diálogo.

			Document Presets: Disponibiliza estilos de publicações criados previamente. 

			[image: Pages 01.jpg]

			Fique de Olho | Os estilos de publicação podem ser criados por meio do comando Define, no menu File > Document Presets. Os estilos existentes serão listados na janela e poderão ser editados através do botão Edit. Para a criação de um novo estilo, o botão utilizado será o New. Existe ainda a opção de importar estilos de publicações que estão salvos em diretórios/pastas específicos, por meio do botão Load.

			[image: New 02.jpg]

			Intent: Determina se a publicação será dirigida para mídia impressa (Print) ou para Internet (Web).

			Number of Pages: Quantidade de páginas da publicação. Pode ser alterado posteriormente ao se incluir ou excluir páginas a qualquer momento da diagramação.

			Facing Pages: Permite que as margens sejam tratadas como interna/externa para publicações com acabamento na lombada (livro, revista) ou como direita/esquerda se o acabamento for refile simples (folheto, mala direta, cartaz). 

			Start Page #: Determina qual será a numeração da primeira página do documento.

			Master Text Frame: Coloca um frame na página-mestre para permitir o fluxo de texto automático para a publicação.

			Page Size: Exibe uma lista de formatos mais comuns. A opção Custom aparece quando se configura um formato que não está disponível na lista.

			Width/Height: Exibe as medidas de largura e altura do formato de página pré-definido e permite a digitação de valores para formatos personalizados.

			Orientation: Posição vertical (portrait) e horizontal da página (landscape).

			Columns: Número de colunas (Number) e espaço entre elas (Gutter). Durante o desenvolvimento da diagramação da publicação essas opções podem ser alteradas.

			Margins: Determinam a área de mancha da publicação. Dependendo da opção Facing Pages (ligada / desligada) pode-se ter como resultado Left / Right (esquerda / direita) ou Inside / Outside (interna / externa) das margens laterais da página.

			Do lado direito da tela, existe um botão entitulado More Options, que abre mais opções para o comando New.

			Bleed: Determina a área de sangria. Dependendo do tipo de acabamento é necessário colocar valores diferentes para cada lado da sangria. Se os valores forem iguais, basta digitá-lo em um dos campos e clicar no ícone da corrente que o programa duplicará o valor digitado anteriormente nos demais campos. 

			Fique de Olho | Essa opção deve ser acionada também no momento da impressão no comando Print ou na exportação para PDF no comando Export, disponíveis no menu File, possibilitando a reprodução da sangria.

			Slug: Determina a área do pasteboard que pode conter informações que se queira imprimir, como marcas de dobra, logotipos ou informações adicionais.

			Fique de Olho | Essa opção deve ser acionada também no momento da impressão no comando Print ou na exportação para PDF no comando Export, disponíveis no menu File, possibilitando a reprodução da sangria.

			Fique de Olho | Altere as especificações de página, com exceção da opção Master Page Frame, durante o processo de diagramação, utilizando Document Setup, localizado no menu File.
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			Altere as configurações de margem no comando Margins and Columns disponível no menu Layout.

			[image: 21.tif]

			3. Gerencie as páginas pela paleta Pages, que fica disponível do lado direito da tela. Caso ela não esteja disponível, clique em Page, no menu Window. Pela paleta é possível deslocar, inserir e excluir páginas visualmente.

			[image: Pages 03.jpg]

			4. Note que o ícone de alteração de formato de página disponibiliza um submenu que lista vários formatos. A opção Custom Page Size permite personalizar o formato da publicação.

			01.2 | Rotação de páginas

			As páginas podem ser rotacionadas para facilitar o trabalho de diagramação de projetos que precisam estar posicionados em orientações diferentes. Por exemplo, uma página na vertical, mas com uma tabela que o leitor deve deixar a página na horizontal para ler.

			1. Escolha uma página selecionando-a na paleta Pages. 

			2. Acesse o submenu da paleta, escolha Rotate Spread View e clique no ângulo de rotação. As opções são: 90º CW (sentido horário), 90º CCW (sentido anti-horário) e 180º.

			[image: Rotate Spread 01.jpg]

			3. Note que na paleta ao lado da página selecionada, exibe uma indicação da rotação, mesmo que a miniatura continue na vertical, no caso do exemplo.

			[image: Rotate Spread 02.jpg]

			4. No layout é possível visualizar a página rotacionada. Atente para o fato de que a rotação da página será apenas operacional. Ao fechar o arquivo, note que a página fica na posição original.

			5. Se houver necessidade da página, ficar realmente rotacionada no resultado final utilize a opção de formatos diferentes.

			[image: Rotate Spread 03.jpg]

			01.3 | Aplique cores nas páginas (Novidade CS5)


			É possível aplicar cores nas miniaturas das páginas, dentro da paleta Pages para que fiquem melhor organizadas visualmente. 

			Basta escolher as cores disponíveis no comando Colour Label localizado no submenu da paleta Pages.

			As páginas não ficam coloridas na impressão.
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			1. A paleta Pages também possui um submenu que permite dar acesso a outros comandos relacionados com atributos de controles de página. Alguns comandos relacionados a manipulação de página também podem ser acessados pelo menu Layout > Pages.

			2. Utilize o comando Insert Pages para inserir páginas na publicação, especificando a localização dessas páginas, antes ou depois da página de referência. Escolha também qual a página-mestre que estará sendo vinculada à estas novas páginas.
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			Fique de Olho | Para manter as páginas espelhadas sempre juntas, selecione as páginas em questão e desmarque a opção Allow Selected Spread to Shuffle no submenu da paleta Pages. Estas páginas serão identificadas por um colchete ao redor no número na visualização da paleta.

			[image: Pages 05.jpg]

			Fique de Olho | As páginas geralmente são espelhadas em duplas, porém em determinados projetos será necessário criar páginas espelhadas com três ou mais páginas. Para que essa ação seja possível é preciso desmarcar a opção Allow Document Pages to Shuffle, no submenu da paleta Pages. Com o mouse é possível posicionar as páginas conforme a diagramação desejada na paleta Pages.
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			01.4 | Páginas de formatos diferentes (Novidade CS5)


			O InDesign CS5 permite a existência de páginas com diferentes dimensões e orientações de páginas em um mesmo documento.

			Selecione a página a ser alterada e clique no ícone posicionado na parte inferior da paleta Pages.
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			Aparecerá um submenu com opções de formatos, incluindo a Custom Page Size que abre a possibilidade de personalização por meio de um quadro de diálogo.
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			É possível escolher um formato personalizado e mudar a orientação da página, bem como nomear essa opção para que fique disponível sempre que o ícone for acessado.

			[image: Multiplas paginas 04.jpg]

			A alteração do formato e orientação modificados, podem ser visualizados na própria tela do InDesign e nas miniaturas da paleta Pages.

			01.5 | Páginas-mestre

			Um dos mais interessantes recursos de automatização em aplicativos paginadores são as páginas-mestre. 

			Essas páginas permitem que o usuário crie um padrão utilizando elementos que são comuns a todas as páginas da publicação, como cabeçalhos, rodapés, números de página ou quaisquer itens que façam parte do projeto gráfico e que aparecem em várias páginas na mesma posição.

			Páginas-mestre - procedimentos básicos

			A criação da página-mestre está relacionada com o diagrama base, e deve ser norteado pelo projeto gráfico visando manter as características das páginas sempre iguais e ao mesmo proporcionando automação em algumas tarefas relacionadas com esses itens, como a numeração de página, por exemplo.

			As alterações nas páginas-mestre podem ocorrer a qualquer momento do processo de diagramação.

			Páginas-mestre - procedimentos passo-a-passo

			1. Determine a quantidade e as características que as páginas-mestre devem possuir segundo o seu projeto gráfico.

			2. Para criar uma página-mestre nova utilize o comando New Master, no submenu da paleta Pages.
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			3. Nomeie as novas páginas-mestre na opção Name, escolha se a nova página-mestre é derivada de uma outra existente, no campo Based on Master, além de escolher a quantidade de página em Number of Pages. A nova página-mestre estará disponível na paleta Pages.

			Fique de Olho | Para vincular uma página da publicação com uma nova página-mestre é necessário clicar na página-mestre e arrastá-la até a página desejada. Se preferir, pode-se utilizar o comando Apply Master to Page no submenu da paleta Pages, escolher a mestre a ser aplicada e as páginas que deverão ser modificadas.

			4. Escolha o modo como a numeração de página deve aparecer na publicação, que deve ser colocada na página-mestre, para servir de referência à todas as páginas da publicação. Essa numeração independe da variedade de páginas-mestre da publicação. 

			Fique de Olho | Ao adicionar uma nova página à publicação, o InDesign se encarregará de alterar a numeração de todas as páginas seguintes para respeitar a sequência numérica da publicação, mesmo que existam páginas que não serão numeradas, ou seja, com a impressão do número de página. 

			01.6 | Numeração automática

			1. Para utilizar o recurso de numeração automática é necessário clicar em uma página-mestre, adicionar um frame de texto, e com a ferramenta de texto, escolher o comando Current Page Number, no menu Type > Insert Special Character > Markers.

			[image: Numeracao auto 01.tif]

			2. Note que a visualização da numeração é o prefixo utilizado para nomear a página-mestre. Nela, esse texto é igual a qualquer outro, por isso pode ser formatado com todos os recursos disponíveis, tais como fonte, tamanho e alinhamento. Nas páginas comuns, a numeração aparecerá conforme essas formatações.
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			3. Altere se necessário, as configurações dos números da numeração de página, o início de numeração ou inclusão de seção por meio do comando Numbering & Section Options, localizado no submenu da paleta Pages, conforme as descrições a seguir.

			[image: Pages 08.jpg]

			Start Section: Determina o uso de seção na publicação.

			Automatic Page Numbering: Faz a numeração automática seguindo as posições das páginas na paleta Pages.

			Start Page Numbering at: Determina qual o número em que começará a numeração.

			Section Prefix: Inclui um prefixo para a seção, que pode ser caracter ou espaço, contendo até 8 caracteres. Por exemplo, “A 16” ou “A - 16”.

			Fique de Olho | Não é possível inserir um espaço em branco pressionando a barra de espaço. Em vez disso, copie e cole um caracter de espaço de largura fixa da janela do documento. Observe que sinais de adição (+) e vírgulas (,) não podem ser usados sem prefixos de seção.

			Style: Tipo de numeração, por exemplo arábico ou romano.

			Section Marker: Caracter inserido na página, no local de um caracter marcador de seção que é exibido quando você escolhe o comando Section Marker no menu Type > Insert Especial Caracter > Markers.

			Include Prefix when Numbering Pages: Se estiver marcado os prefixos de seção serão impressos ou gerados no sumário e no índice.

			Document Chapter Numbering: Coloca numeração automática nos capítulos da publicação.

			Style: Especifica o tipo de numeração dos capítulos.

			Automatic Chapter Numbering: Coloca a numeração de capítulos de forma sequencial.

			Start Chapter Numbering at: Determina qual o número em que começara a numeração dos capítulos.

			Same as Previous Document in the Book: Utiliza o mesmo número de capítulo do documento anterior de um Book. Essa opção só é válida no caso do documento atual fazer parte do mesmo capítulo do documento anterior em um Book.

			Book Name: Se o arquivo em que está trabalhando faz parte de um Book, o seu nome aparecerá nessa opção.

			4. A numeração de página é uma sequência configurada determinada pela página mestre e as opções do comando Numbering & Section Options. Pelo mesmo comando é possível colocar na publicação seções, ou seja, numerações diferentes como numeração romana de algumas páginas e arábica de outras.

			5. Para fazer uma seção, selecione a página onde começará, escolha o comando Numbering & Section no submenu da paleta Pages e escolha o tipo de número que deseja utilizar em Style. Se a numeração terá uma nova referência marque o campo Start Page Numbering e defina em que número a numeração deve começar.

			01.7 | Visualização

			01.7.1 | Zoom

			A aplicação de diferentes visualizações por meio de aplicação de fatores de zoom, é fundamental para que possamos ter uma visão mais aproximada dos elementos que estamos manipulando ou para ter uma visualização geral da página.

			[image: Ferramenta de zoom a.tif]

			O InDesign possui a ferramenta de zoom posicionada na barra de ferramentas e que disponibiliza a ampliação e redução de incrementos de 25%. Para ampliar, utilize a ferramenta na área em que se deseja aumentar a visualização, para reduzir pressione a tecla Alt/Option e depois clique com a ferramenta.

			A ferramenta Hand Tool permite ajustar o posicionamento pelo cursor do mouse que se transforma em uma mãozinha.

			Fique de Olho | Para facilitar é possível utilizar teclas de atalho. O Command/Control + 0 (zero) encaixa a página na tela, Command/Control + (sinal de mais) amplia, e Command/Control - (sinal de menos) diminui. 

			Fique de Olho | Para acessar a ampliação setorial experimente clicar e segura o mouse enquanto pressiona a tecla Alt/Option.

			Se preferir, digite o fator de zoom na barra de propriedades, localizada na parte superior da tela.

			[image: Zoom 01.jpg]

			Existem várias opções de zoom disponíveis no menu View. Com destaque para Entire Pasteboard que visualiza além da página, a área ao redor dela (pasteboard).

			[image: Zoom 02.jpg]

			01.7.2 | Modos de visualização

			Existem várias formas de visualização dos layouts dentro do InDesign, que permite ter noção de como será a aparência do projeto no final, utilizando ou não sangria (bleed) e deslocamento (slug).

			Modos de visualização - procedimentos passo-a-passo

			1. Abra um arquivo diagramado que possua sangria e deslocamento.

			2. Escolha a opção Normal na última ferramenta da barra.

			[image: Visualizacao 01.jpg]

			3. Veja que todas as linhas de construção dos frames e as guias estão aparecendo.

			[image: Visualizacao 02.jpg]

			4. Troque para a opção Preview. Observe que o layout aparece da maneira como será quando for impresso.

			[image: Visualizacao 03.jpg]

			5. Alterne agora para a opção Bleed. É possível ver o resultado final do layout só que com a sangria.

			[image: Visualizacao 04.jpg]

			6. Mude para o modo Slug e veja que aparece além da sangria, a área de deslocamento.

			[image: Visualizacao 05.jpg]

			7. E, por fim, veja o modo Presentation. Essa é uma das opções de visualização das páginas como se fosse uma apresentação de slides.

			[image: Visualizacao 06.jpg]

			01.7.1.1 | Criação de apresentações

			[image: Presentation.jpg]

			Os arquivos de InDesign podem ser transformados em apresentações utilizando o modo de visualização Presentation.

			A movimentação dos slides (páginas) pode ser feita usando as teclas de setas ou com o clique do mouse.

			A seguir algumas teclas e suas funções durante o modo de visualização Presentation:

			
					
Esc: Sair do Modo Presentation.

					
Home: Primeiro slide.

					
End: Último slide.

			

			01.7.1.2 | Visualização de imagens no modo Preview

			[image: Preview.jpg]

			A visualização da imagem, que está fora da prismagem do frame, pode ser visualizada também no modo Preview, incluindo o uso do Indicador de Conteúdo (círculo no centro do frame).

			01.8 | Ajuste de layouts

			O recurso ajuste de layout possibilita rediagramar automaticamente os elementos quando existe alguma alteração de tamanho ou orientação da página, assim como na quantidade de colunas e especificações das margens.

			[image: Ajuste Layout 02.jpg] [image: Ajuste Layout 03.jpg]

			Escolha o comando Layout Adjustment localizado no menu Layout.

			[image: Ajuste Layout.jpg]

			Enable Layout Adjustment: Habilita o recurso e o acesso às opções disponíveis.

			Snap Zone: Margem de limite para o ajuste automático entre os elementos e as linhas-guia, colunas e margens da página.

			Allow Graphics and Groups to Resize: Determina que as imagens e os grupos de frames podem ser redimensionados durante o ajuste automático.

			Allow Ruler Guides to Move: Reposiciona as guias de referência no novo layout.

			Ignore Ruler Guide Alignments: Ignora os alinhamentos dos elementos relacionados às linhas-guia.

			Ignore Object and Layer Locks: Ignora elementos em camadas travadas.

			Fique de Olho | A mudança automática de layout será mais precisa se os elementos estiverem alinhados por guias e colunas configuradas no programa, criadas pelo comando Margin and Columns, localizado no menu Layout.

			Fique de Olho | O recurso auxilia bastante, mas dificilmente fará um trabalho perfeito. Portanto é altamente recomendável uma revisão atenta em todas as páginas do documento.

			01.9 | Modelos (templates)

			Na editoração de publicações periódicas é bastante comum utilizar o arquivo da edição anterior e diagramar por cima a próxima edição.

			Porém, como cada edição é peculiar, e é muito fácil fazer pequenos ajustes, como mudanças sutis no projeto gráfico, é comum que haja, aos poucos, um distanciamento entre o projeto original e o atual, principalmente se a publicação for diagramada por uma equipe de pessoas com modos de trabalho diferentes.

			Para evitar que isso aconteça é interessante criar um documento com as características do projeto gráfico, contendo estilos, bibliotecas de cores, páginas-mestre, entre outras configurações gerais.

			Nesse caso, o ideal é criar um template, gabarito ou modelo, usando um arquivo de InDesign que contém as padronizações do projeto, mas possui uma extensão diferente: .indt. (A extensão de documentos do 
InDesign é .indd).

			Templates - procedimentos passo-a-passo

			1. Crie um arquivo com todas as características do seu projeto gráfico.

			2. Use o comando Save As do menu File. Escolha a opção InDesign CS5 template no campo Salvar como tipo.

			[image: Template.jpg]

			3. Agora abra esse arquivo. Note que o arquivo vem sem nome já que se trata de uma cópia do template.

			Faça as alterações necessárias e salve-o normalmente como uma publicação do InDesign.

			01.10 | Exportação para abertura em versões anteriores do InDesign (Novidade CS5)


			Para abrir os documentos criados no InDesign CS5 em versões anteriores do produto é necessário fazer a exportação dos arquivos por meio do comando Export do menu File e escolher a opção InDesign Markup (IDML) no campo Salvar como tipo.

			[image: Exportacao.jpg]

			Faça um Experimento | Crie um documento novo, configure-o com várias páginas e manipule-as com a paleta Pages. Faça várias páginas-mestre com opções diferentes de numeração. Insira e remova algumas páginas e observe como o InDesign gerencia essas ações. Experimente as formas de zoom e visualização. Salve sua publicação como um arquivo de documento e de template e veja as diferenças. Teste um ajuste automático de layout em um documento previamente diagramado.
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